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INTRODUCTION 

Access is a database program, created by Microsoft.  At the end of 1999 the Trust 
upgraded to Access 2000 (running in Windows NT). 

What Is A Database? 
Databases are used to store information in a structured way. 

Computerised databases enable you to store large amounts of information.  You can 
then search for any piece of information or sort the information by any criteria.  You 
can cross reference the data easily, and extract data to be viewed on screen or 
printed out in a variety of different formats. 

For example, if you have a database of staff working at a company, you can extract 
the names of all staff who work at a certain location and have been with the company 
for over 5 years.  You can then sort the extracted list alphabetically by surname and 
print it out. 

Multiple Users 
Unlike Word documents and Excel spreadsheets, an Access database can be used by 
several people at the same time.  The changes made by all the users will be saved 
into the same database.  This avoids the need to duplicate data as you can create one 
single database that everyone can access at any time. 

The Aim Of This Manual 
In the Basic manual you learnt how to use an existing database.  This included moving 
through data records, inputting new data, creating queries to extract data and creating 
reports to produce documentation of the data. 

In this Intermediate manual you will learn how to create a simple Access database, to 
be used by a small number of people.  This will involve planning the database, 
creating tables to store your data and creating forms to facilitate and control the data 
inputting process. 

Instructions 
All the important instructions in this manual appear in bold.  Toolbar button and Menu 
commands appear bold and in quotation marks.  Keyboard instructions are bold and in 
square brackets.  For example: In the "Edit" menu, select "Undo", or use the 
combination command [Ctrl]+[Z]. 
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NEW FEATURES IN ACCESS 2000 

Access 2000 is very similar to Access 2.  But there are a few exciting new features for 
intermediate users. 

Feature Description of Change 
Database Window The Database Window has been reformatted.  There is 

also a new database object, called a Page. 

 

Drop Down Lists in 
Tables 

This is a useful new feature.  You can now create a drop 
down list in a table to allow users to input values by 
selecting them in the list.  Previously you could only do this 
on a form. 

 

(See section on Creating a Drop Down List in a Table). 

Hyperlinks There is a Hyperlink field property that allows you to use 
hyperlinks in tables and fields to link to any web page, 
document, spreadsheet or PowerPoint presentation, on the 
network or the Intranet. 

Two Digit Year Dates Access 2000 recognises two digit dates between the 
period 1930 to 2029.  But it is probably a good idea to 
format all date fields to display the year in a four digit 
format. 

Conditional Formatting 
on a Form 

You can now format a field on a form so that its formatting 
changes depending on its current value. 

(See section on Conditional Formatting). 
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Feature Description of Change 

Print Relationships You can now print out the relationships between the tables 
in your database. 

(See section on Printing Relationships). 

Subdatasheets in 
Tables 

This is another useful new feature.  If two tables are linked 
together in a one to many relationship, you can actually 
view the data from the sub-table in the main table. 

 

Access Pages Pages are a new type of Access object (like tables, queries 
and forms). 

A Page is like a web form, allowing people to input data 
into an Access database via the Internet (or Intranet) using 
a web browser such as Microsoft Explorer. 

 

Creating Access Pages is not covered in this manual. 

Converting Old 
Databases 

You can covert old Access databases to Access 2000.  
You can also convert an Access 2000 database down to 
Access 97 if you need to share it with an Access 97 user. 

(See section on Converting an Access 2 Database). 
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DO YOU NEED TO USE ACCESS? 

Before you start thinking about creating an Access database you need to decide if 
Access is actually the right tool for the job. 

Access is a large and complex program that can be used to create fairly sophisticated 
databases.  But if the database you wish to create is quite simple, you may not need 
to learn and use Access.  You could perhaps use Excel, especially if you already know 
how to use it. 

The Benefits Of Excel 
Excel can be used to create and store a table of data that can be sorted, subtotalled, 
and filtered to extract data.  You can also use all the Excel formula to perform any type 
of calculation on the data.  You can link to an Excel workbook to perform a Mail Merge 
to create bulk letters or mailing labels in Word.  You can also create graphs from 
numerical data to display it in a more interesting way.   

Furthermore, if your Excel spreadsheet becomes too large or complicated at a later 
date, you can then export it to Access and build it up from there. 

The Failings Of Excel 
Although Excel has thousands of empty rows, it will begin to slow down if you have 
more than approximately 2000 rows of data.  So you can't use if for large amounts of 
data. 

Complex databases contain multiple tables of data that are linked together.  You 
cannot create this type of relationship in Excel.  (You can create more than one table 
of data, but you cannot link the tables together).  This means you can't ask the 
database questions that cross reference across all the data. 

Although several people can open an Excel workbook if it is stored on a shared area, 
two people cannot have it open at the same time.  Only Access allows multiple users 
to update the same database at the same time. 

In summary - if your database is going to consist of one simple table of data, 
containing fewer than 2000 rows of information and only one person needs to use it at 
a time, then you could use Excel.  Otherwise Access is probably more suitable. 

Having decided that you need to use Access, you can now start designing the 
database. 

DATABASE DUPLICATION 
As more databases are created at the Trust, the likelihood that information is being 
duplicated will increase.  Try to find out if someone has already created a similar 
database to the one you have in mind.  If it already exists, you don't need to recreate 
it. 
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DESIGNING A DATABASE 

It is very important to plan your database out on paper before you do anything in 
Access.  This will save you a lot of time. 

These are the four steps that you need to follow to help you design the database: 

Determine The Purpose Of The Database 
The first step is the most important one.  You must ask yourself – What is the 
database is for?  What is it supposed to do? 

This will help you to determine what information it will need to contain.  For example, if 
you want to keep track of staff being trained, you will need to store information about 
who the staff were, what they were trained on and when they were trained. 

It is also useful to ask - What information do I want out of the database? 
If you know what information you need to get out of the database, then you will know 
what information you need to put into it.  For example if your manager might ask you 
to determine if more men attend training than women then you will need to include 
gender information in the database. 

Think ahead.  What information might people start asking for in a years time?  It is 
easier to include this data at the beginning, than to have to add it later. 

 

Determine What Fields You Need 
Having determined the information you wish to store in the database, you must now 
break it down into basic units of data.  These are known as fields. 

For example, information about people can be broken down into the following fields: 
title, first name, middle name, surname, date of birth, gender, ethnic origin, etc. 

The only fields you don’t need to include are those that will actually contain the results 
of calculations based on other existing fields.  For example the VAT on a product can 
be calculated from the product price and the VAT rate. 

 

Determine What Tables You Need 
Having decided what data fields you want to store in the database, you can divide the 
fields into fundamental groups.   

Make sure every field is allocated to one group.   

Each group of fields will be stored in a separate table. 

Give each group a name that describes all the data in that group.  You can use these 
as the table names. 
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Determine The Relationships Between The Tables 
Having chosen the tables you need, you must now determine the relationships 
between the tables.   

There are three types of relationship:  

One to Many Each record in table A can relate to many records in table B.   

For example, If you have a table of staff names and a table of 
training attendance, then the tables have a one to many relationship 
as each staff member could attend many training courses.  This is 
the most common type of relationship. 

Many to Many Each record in table A can relate to many records in table B and 
each record in table B can relate to many records in table A.   

For example, If you have a table of staff names and a table of 
computers, then to record which computers are being used by 
which staff you would have to set up a many to many relationship 
as several staff could use the same computer and several 
computers could be used by the same person. 

One to One Each record in table A can have no more than one matching record 
in table B. 

This type of relationship is unusual as the data from the second 
table is usually just added into the first table. 

 

COMMON DESIGN PROBLEMS 
There are several common design problems: 

− Avoid creating one table with a large number of fields that don't all relate to the 
same subject.  Create different tables for each subject. 

− Avoid having fields that are intentionally left blank in many records because they 
aren't applicable to those records.  This usually means that the fields belong in 
another table. 

− Avoid having different tables which contain the same fields.  You should not have 
to repeat the same information in different tables.   

− If two tables are linked together, the field that links them will appear in both tables.  
But you should never create fields in different tables, with the same name, if they 
contain unrelated data.  This is often done with common fields such as Phone, 
Date or ID.  You should use names that differentiate the fields, ie Home Phone, 
Work Phone. 

− Don’t use the word Date, on its own, as a field name as this is a special code word 
used by Access to calculate the current date.  But it is okay to use Date in 
combination with other words, eg Start Date, End Date, Date of Birth. 

− If you will ever need to provide access to your database via the Intranet, don’t use 
spaces in your field, table or query names.   
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DESIGN EXAMPLE 

Here is an example for the design of a simple Training Database for staff working at a 
company. 

Staff Table

Staff ID
First Name
Surname
Department
Office
Extension
Start Date
Status
Gender

Training Table

Staff ID
Course
Date
Attend
Late

One to Many
Relationship

 

There are two tables.  The Staff Table contains information about each staff member.  
The Training Table contains information about each time a person attends a training 
course. 

The Training Table has a one to many relationship with the Staff Table, as each 
person could attend many training courses. 

Thinking Ahead 
To determine the fields that each table needs, you need to think of the questions the 
database will need to answer. 

If you will need to know how soon a person was trained after joining the company then 
you will need a field in the Staff Table that contains the Start Date. 

If you will ever need a breakdown of training for permanent, contract and part time 
staff then you will need a field in the Staff Table that contains the Status. 

If you will ever need to know how many women have attended a particular course then 
you will need a field in the Staff Table that identifies the Gender. 

If you will need to know which staff did not turn up for training, as well as those that 
did, you will need an Attend field in the Training Table to identify those that did or did 
not turn up. 

If you will need to know who is persistently late for training, then you will need a field in 
the Training Table called Late, to contain the number of minutes each person is late. 

 

This should demonstrate the need to think about the database before you create 
anything in Access.   

 

Don't forget to talk to the other people who will use this database to see what their 
needs are. 
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CREATING A NEW DATABASE 

Once the database has been thoroughly planned on paper, you can start to create it in 
Access. 

To Start Up Access 

• Click on the “Start” button, select 
“Programs, then select “Microsoft 
Access” 

Access will open up and the Startup dialog 
box will appear. 

 

 

 

To Create A New Database 

• In the Startup dialog box, select create a new “Blank Access database” and 
click “OK” 

Or if that is not showing, you can click on the “New” button  on the Access toolbar.  
The New dialog box will appear.  In the General tab, select the “Database” icon and 
then click “OK”. 

The File New Database dialog box will appear.   

You must give your database a name 
and choose where you want to save 
it before you can do anything else. 

• Enter a file name for the 
database 

• Select a folder to store it in 

• Click on the “Create” button 

The new database will be created. 

The Database Window for your new 
database will appear. 

You can now create the tables that 
will contain the data. 
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CREATING A TABLE 

Having created a new blank database, you are ready to create the tables that will 
contain the data. 

To Create A New Table 
In the Tables tab in the Database window. 

• Click on the "New" button 

 

 

 

The New Table dialog box will appear. 

There is a Table Wizard available to help you 
create a new table.  But it is best to create 
new tables manually in Design View. 

• Select Design View 

• Click “OK” 

The Table Design window will appear. 

 

Each row in the Table Design window represents a column of data in the actual table. 

The Field Name is the name of the column of data.   

The Data Type specifies the type of data in a column (eg text, numbers, dates, etc.). 

The Description is just a notes area to explain the field to other users of the 
database. 
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To Add A Field To A Table 

 

• Click in the Field Name column and enter a name 

Field names can be longer than eight characters and can contain spaces. 

 

☺TIP  Never use the same name for different fields in the same database. 

It is also handy not to create field names that are much longer than the 
values the fields will contain. 

 

You must now specify the type of data that will be stored in the field (see section on 
Data Types). 

• Click in the Data Type column 

A drop down menu arrow box will appear. 

• Click on the arrow and select a data type 

 

 
 

You can now enter an explanation of the field into the Description box, if you want to 
explain the field to other users. 

This text is displayed in the status bar at the bottom of the screen when the user 
selects the field in a table or form. 

 

• Enter field description 

 
 

You can then edit the Field Properties for each field (see section on Field Properties). 

You can then create a Primary Key if you need to link this table to another table (see 
Primary Key section). 

You can then save the table (see section on Saving A Table).  
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DATA TYPES 

There are ten data types.  The last two are new to Access 2000. 

Data Type Stores Size 
Text Text, up to 255 characters Up to 255 

bytes/characters 
Memo Large amounts of text, over 255 characters 

(usually several sentences or paragraphs) 
Up to 65,000 bytes 

Number Numbers 1, 2, 4 or 8 bytes 
Date/Time Dates and times 8 bytes 
Currency Monetary values, eg £44.50 8 bytes 
AutoNumber An automatic counter that generates a new 

number for each new record: 1, 2, 3, 4, etc.  
(This was called Counter in Access 2) 

4 bytes 

Yes/No A field with a ready made Yes or No options 1/8 byte 
OLE Object OLE objects or graphics (eg a scanned 

photo, logo or signature) 
Up to 1 gigabyte 

Hyperlink Links to any file on the network or Intranet 2048 bytes 
Lookup 
Wizard 

This is a new feature that starts a wizard to 
help you create a drop down menu field 

4 bytes 

 

☺TIP  Fields containing telephone numbers should be set as Text, because 
numbers are not allowed to have spaces in them, eg 0181 357 5000. 

HYPERLINK 
The Hyperlink data type creates a field that can contain links to any file on the network 
or Intranet (or Internet). 

For example, having created a Hyperlink field, the user could enter: 

http://nhhtnews.nhht/hr/default.htm to create a link to the Human Resources 
home page on the Intranet. 

\\grofps1\IT\Harvey\letter.doc to create a link to a Word document called 
letter in the Harvey folder, on the IT shared 
area on the grofps1 server. 

You can also enter a friendlier name for the link if you enter it in the format: 

friendlyname#address    eg  HR Home Page#http://nhhtnews.nhht/hr/default.htm 

LOOKUP WIZARD 
The Lookup Wizard data type will guide you through the steps to create the drop down 
menu.  The best way to do this is to create a separate table to contain the drop down 
values first.  Then use the Lookup Wizard data type to link to this table.  Don’t try this 
until you have read through the section ‘Creating a Combo Box’. 
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FIELD PROPERTIES 

Field Properties allow you to control the appearance of data, specify default values, 
and speed up the process of searching and sorting. 

The field properties are set in the Table Design window. 

Selected 
field

Field 
Properties 
for selected 
field

 

The field properties available varies for each field type.  This is a summary of all the 
available field properties. 

Field Property What It Controls 

Field Size Maximum number of characters allowed in field  

Format Appearance of dates and numbers (and text) 

Decimal/Places Number of places shown after the decimal point 

Input Mask Forces inputted data to appear in a particular format 

Caption Creates an alternative label that will appear in Forms (instead of 
the actual field name) 

Default Value Automatically fills a value into the field when a new record is 
created 

Validation Rule An expression that limits the data that can be entered into the 
field 

Validation Text The message that appears when the ValidationRule is not 
satisfied 

Required Field can't be left blank 

Allow Zero 
Length 

Allows zero length strings to be stored in a Text or Memo field 

Indexed Speeds up searches on fields that are searched frequently 

Unicode 
Compression 

Turns on Unicode compression  

 

☺TIP  Changing field properties can alter existing data in the table.  Try to set all the 
appropriate field properties before you start entering data into the table. 
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FIELD SIZE 
The options available differ for Text and Number fields. 

Field Size For Text Fields 
The field size can be set between 1 and 255 characters.  The default setting is 50. 

If a field is to store eight character codes, you may wish to change the setting to 8 so 
that no one can accidentally enter a longer code.  If you want to enter text that might 
be longer than 50 characters you will need to increase the size. 

Field Size For Number Fields 
There are seven options, but you need only use two of them. 

Select Double if you wish to use numbers with decimal points. 

Select Long Integer if you do not need to use decimal points (or if you need to link 
this field in a One to Many relationship with a Counter in another table). 

FORMAT 
Access can display number and date values in many different formats. 

Number Formats 
These are examples of the number format types.  The exact number of decimal places 
shown will vary if the Decimal field property has been altered. 

Format Name Number Without Formatting Number With Formatting 

General Number 5678.5 5678.5 

Currency 5678.5 £5678.50 

Euro 5678.5 ∈5678.50 

Fixed 5678.5 5678.50 

Standard 5678.5 5,678.50 

Percent 0.345 34.50% 

Scientific 5678.5 5.67E+03 
 

Date & Time Formats 
There are a selection of date and time formats.  But due to the Year 2000 dates 
problem, you should not use the ones containing two digit year dates, as Access 
guesses which century a two digit date belongs to. 

You can use the Long Date format, which will display a date in the format 31 January 
1998. 

Or you can enter the format code dd/mm/yyyy into 
the format property box of any date field to display 
the dates in the format 31/01/1998.  
You can use any of the three time formats.  These are Long Time (4:30:00 PM), 
Medium Time (04:30 PM) or Short Time (16:30). 
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Yes/No Formats 
The default format for a Yes/No data type is to use "Yes" and "No".  But you can also 
choose "True" and "False", or "On" and "Off". 

The underlying values stored in the table are actually -1 (Yes) and 0 (No). 

Custom Formats 
If the standard formats do not meet your needs, you can create your own customised 
format by entering the format into the Format box.  These are some examples: 

Customised Format Original Number Formatted Number 

"Acc No " 0000 115 Acc No 0115 

mmm yyyy 31/01/98 Jan 1998 

hhmm "hours" 2:00 PM 1400 hours 

DECIMAL/PLACES 
The default Auto setting uses the decimal points associated with the selected Format. 

If you select a value, the decimal places of the selected Format are overridden by the 
selected value. 

INPUT MASK 
If all the data to be inputted into a field has the same format, you can control and 
simplify data entry by creating an input mask. 

For example, if all dates should appear in the format 31/01/1998, you can create an 
input mask in the format ##/##/####.  The slash separators are already in place (so 
they don't have to be typed) and each # marks the point at which a number should be 
entered. 

There is an Input Wizard to help you create an input mask.  To create an input mask 
using the Wizard. 

• Click in the Input Mask box 

 

A button showing three dots will appear. 

• Click on the button to start the Input Mask Wizard 

• Follow the steps of the Wizard 

 

CAPTION 
To keep column widths in your tables small, it is best to use short field names.  
However, in a Form there is more space to display a proper name for a field.  The 
Caption property allows you to specify a longer name for the field that will be used in 
any forms containing the field instead of the actual field name. 

For example you could use DoB as a field name and Date of Birth as the caption. 
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DEFAULT VALUE 
If a field usually has the same value entered into it you can set that value as the 
default value.  This saves you having to input it each time.  Then you only have to 
input a value when it is different from the default value. 

For example in the Status field in our Staff table we record whether staff are 
permanent, contract or part time.  Most people will be permanent, so that could be set 
as the default value. 

 
 

VALIDATION RULE 
The Validation Rule controls the values that can be entered into a field. 

It is important that values are entered into fields correctly and consistently, especially if 
you will be using that field to query data by. 

For example, in the Status field of our Staff table, you do not want some people to use 
the word "Permanent", and some to use the word "Perm".  Because a query to display 
all "Permanent" staff will not display staff who are "Perm". 

Here are some examples: 

Validation Rule Values That Can Be Entered 

"Permanent" or "Contract" 
or "Part Time" 

Value can only be Permanent, Contract or Part Time 

>0 Value must be greater than zero 

Like "H???" Value must be four characters, starting with the 
letter H 

>=#1/1/1995# Date cannot be before 1st January 1995 
 
 

VALIDATION TEXT 
If a field's Validation Rule is broken, a 
message box will appear.  You can 
specify the text in the message box by 
setting the Validation Text. 

 
 
 

☺TIP  If there are a limited number of values that can be inputted into a field, you 
can create a drop down list, containing the available options, to speed up and 
control the inputting process.  (See section on Creating a Combo Box on a 
form). 
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REQUIRED 
If you want to force users to input a value into a field, so that it is not left blank, you 
can use the Required property. 

When the Required property is 
changed to Yes (from the default 
value of No), it becomes compulsory 
to enter a value into the field.   

If a value is not entered into the field, 
a message box will appear. 

ALLOW ZERO-LENGTH 
This property relates to empty fields.  If you turn it on, it allows you to differentiate 
between two types of empty fields: 

- Fields that are empty because the value is currently unknown.   
This is a null value. 

- Fields that are empty because the value does not exist for that record.   
This is a zero-length value. 

When the Allow Zero Length property is turned off (which is the default setting), all 
empty fields are treated as null values. 

When the Allow Zero Length property is turned on, you can make a field zero-length 
by entering "" (two double inverted commas with no space in between).  Or you can 
leave the field empty to make it a null field. 

Creating this distinction can be useful if you will need to create queries that can 
differentiate between these two types of empty fields. 

INDEXED 
The Index property speeds up the process when you sort or find by that field.  But if 
you turn on the Index property for too many fields, it will slow Access down. 

Turn on the Index property for a field if: 

- It is not a primary key 

- The values stored in it vary greatly 

- It is often used to find records (using Sort or Find) 

There are three Index options: 

No Index option turned off 
Yes (Duplicates OK) Creates an index on the field.  The same value can appear 

twice in the field. 
Yes (No Duplicates) Creates a unique index on the field.  The same value cannot 

appear twice in the field. 

UNICODE COMPRESSION 
Compresses the data to save memory space.  Leave on the default value Yes. 
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PRIMARY KEY 

The Primary Key is a field in a table used to uniquely identify each record. 

It is good practice to set a primary key in each table (unless the table is just being 
used to provide a list of options in a Combo Box or List Box on a form). 

If you intend to link two tables together you must have a primary key on the one side 
of a 'one to many' relationship. 

The easiest data type to use as a primary key is an AutoNumber, because it 
automatically gives each record a unique number. 

Staff TableStaff Table

Staff ID (Primary Key)
First Name
Surname
Department
Office
Extension
Start Date
Status
Gender

Staff ID (Primary Key)
First Name
Surname
Department
Office
Extension
Start Date
Status
Gender

Training TableTraining Table

Staff ID (Foreign Key)
Course
Date
Attend
Late

Staff ID (Foreign Key)
Course
Date
Attend
Late

One to Many Relationship

 
 

To Create A Primary Key 
When the table is open in design view. 

• Click on the field selector to select the field you wish to make the primary key 

• Click on the "Primary Key" button  on the Toolbar 

 

A small key icon will appear in the field selector to identify the primary key. 

 

To Turn Off The Primary Key 
Turning off the Primary Key removes the primary key function without deleting the 
field.   

When the table is open in design view. 

• Click on the field selector to select the primary key field  

• Click on the "Primary Key" button  on the Toolbar 
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Setting Two Fields As The Primary Key 
You can combine two fields to create a unique reference for each record. 

 

• Select the first field, and then [Ctrl]+click to select the second field 

• Click on the "Primary Key" button  on the Toolbar 

 
 

The "There Is No Primary Key Defined" Message Box 
If you create a new table, save and close it without creating a primary key, a dialog 
box will appear asking if you would like Access to create a primary key for you. 

 

If this table is the ‘one’ table in a one to many relationship then it must contain a 
primary key. 

• Select “Yes” 

Access will create a new AutoNumber field called "ID", which will be set as the primary 
key.  But you should rename this to give it a more specific name. 

If you are going to have several tables in a database, make sure that the ID field in each 
table has a different name (ie Staff ID, Training ID, etc). 

 
But not all tables need to have a primary key.   

If a table is the ‘many’ table in a one to many relationship, or if it is just being used to 
store the values for a drop down list (see Creating A Combo Box), then it does not 
need to have a primary key. 

• Select “No” 
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SAVING A TABLE 

Having created your table with all the appropriate fields and field properties, you will 
need to save it. 

To Save A New Table 
In the Table design window. 

• Click on the "Save" button  on the Toolbar 

The table Save As dialog box will appear. 

 

A common naming convention in Access is to preface all tables, queries and reports 
with a three character name that describes the type of Access element that it is.   

You should also use names that describe the function of the element, especially for 
queries and reports.  Here are some examples: 

Object Name Prefix Example 

Tables Tbl tbl Staff Details 

Queries Qry qry All Staff Trained on Word Basic 

Reports rpt rpt 1998 Training Statistics 
 

• Enter a name for the table 

• Click "OK" 

The table will be saved with that name.  It will now be visible in the Table tab of the 
Database window. 

Tables 
Tab
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CHANGING THE TABLE DESIGN 

If you need to alter the design of the table, you must open it in Design View (rather than 
Datasheet View, which is used to input data into the table). 

To Edit The Table Design 
In the Database window. 

• Click on the Table tab to view all the available tables 

• Click to select the table 

• Click on the "Design" button  

 

The table will open up in Design View. 

 

To Switch Between Design View and Datasheet View 

• Click on the "Datasheet View" button  to view the Datasheet 

 

• Click on the "Design View" button  to view the Design 
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LINKING TABLES 

Only a very simple database will contain just one table.  In fact, you can create this 
type of database in Excel unless you are going to store a large amount of data (ie 
more than about 2000 records). 

Most databases contain several tables that are linked together.  These are known as 
relational databases.  Access is a good tool for creating a relational database. 

There are three ways that you can link tables together. 

One To Many Relationship 
This is the most common type of relationship.   

In a one to many relationship each record in table A can relate to many records in 
table B.   

For example, If you have a table of staff names and a table of training attendance, 
then the tables have a one to many relationship as each staff member could attend 
many training courses. 

Staff Table

1 John Smith

2 Kate Parker

3 Alice Baker

Training Table

1 Windows 12/1/99

1 Word Basic 14/1/99

1 Excel Basic 21/1/99

2 Word Basic 14/1/99

2 PowerPoint 19/1/99
 

 

One To One Relationships 
Each record in table A can have no more than one matching record in table B. 

For example, If you have a table of staff names and a table of who plays golf (for the 
company golf team), each person will only appear on the Golf table once, if at all. 

This type of relationship is unusual because the data from the second table is usually 
combined with the first.  But if there are 1000 staff members and only 20 golf players, 
you will have lots of empty cells if you store the golf data in the staff table. 

Staff Table

1 John Smith

2 Kate Parker

3 Alice Baker

Golf Table

1 Handicap 7

4 Handicap 12

4 Peter Jones

5 Shola Barnes  
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Many to Many Relationships 
Each record in table A can relate to many records in table B and each record in table 
B can relate to many records in table A.   

For example, If you have a table of staff names and a table of current projects, then to 
record which staff are involved in which projects, you would have to set up a many to 
many relationship as one person could work on many projects and each project could 
have many staff working on them. 

To create this type of relationship you must actually create three tables - a staff table, 
a project table and a project/person table.  The staff table and the project table both 
have a one to many relationship with the project/person table. 

Staff Table

1 John Smith

2 Kate Parker

3 Alice Baker

Staff/Project Table

1 A

1 B

3 A

3 B

4 B

Project Table

A Staff Conference

B Summer Challenge

4 Peter Jones

 

 

RELATIONSHIPS PREPARATION 
Before you create a relationship between two tables by linking them together you must 
ensure that: 

1. The main table contains a field that is defined as the Primary Key. 

2. The second table contains an identical field with the same name and data type 
(and field size).  This is known as the Foreign Key.   

☺TIP  But there is one exception to condition 2.  If the primary key is an 
AutoNumber, the foreign key should be a field whose data type is a Number 
and whole field size is a Long Integer.   

 

These are the data types that must match up. 

Primary Key Data Type Foreign Key Data Type 

Text Text 

Number Number (must have the same field size as the 
primary key field) 

AutoNumber Number (the field size must be Long Integer) 
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CREATING RELATIONSHIPS 

Having created the two tables and ensured that a primary key exists in the main table, 
and an appropriate matching field exists in the second table (see previous page), you 
are ready to link the tables. 

This is done in the Database Window. 

• In the "Tools" menu, select "Relationships" 

The Show Table dialog box will 
appear, containing the names of all 
the tables (and queries) in your 
database. 

• Click to select the main table 
you wish to link from 

• Click on the "Add" button 

• Click to select the second 
table you wish to link to 

• Click on the "Add" button 

• Click on the "Close" button 

The selected tables will be added to 
the Relationships window. 

To create a relationship between the 
two tables. 

• Click and drag the field in the 
main table onto the 
corresponding field name in 
the second table 

(In this example you would drag the 
Staff ID field on the left table onto the 
Staff ID field on the right table). 

When you release the mouse a new 
dialog box will appear. 

• Click to turn on the Enforce 
Referential Integrity option 

Access will guess the type of 
relationship you wish to create 
depending on fields you are linking 
together. 
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If Enforce Referential Integrity has been turned on, there are two options that you can 
select: 

Option Effect 

Cascade Update Related Fields: 

 

If you change the data in the primary field 
Access will update the corresponding data in 
the linked fields in the second table. 

Cascade Delete Related Records If you delete a record in the primary table 
Access will delete all related records in the 
second table. 

Having selected the appropriate  relationship you are ready to create the link. 

• Click on the "Create" button 

The link will appear between the two tables in the Relationships window. 

 

A one to many relationship will show a small 1 on one side of the link and an infinity 
sign ∞ on the many side of the relationship. 

To Edit A Relationship 

• Double click on the link line that joins the two tables 

The Relationships dialog box will appear. 

• Make the appropriate changes and then click "OK" 

To Delete A Relationship 

• Click to select the link line that joins the two tables 

• Press the [Delete] key 

A dialog box will appear 

• Click "Yes" 

The relationship will be deleted. 
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To Add Another Table 
At some point you may need to add more tables to the Relationship window. 

• Click on the "Add Table" button on the toolbar  

The Show Table dialog box will appear. 

• Select the table (or query) you wish to add 

• click on the "Add" button 

Repeat this for each table you wish to add. 

• Click on "Close" to close down the dialog box 

 
 

To Remove A Table 
You may wish to remove a table from the Relationship window. 

• Click on the table to select the table 

• Press [Delete] 

 
Having created all the appropriate relationships, you will want to save them and close 
the Relationship window. 

To Save The Relationships 

• Click on the "Save" button on the toolbar  

To Close The Relationship Window 

• In the "File" menu, select "Close" 

 
 

☺TIP  To create a many to many relationship between tables A and B, you must 
actually create a third table C.  You then link table A to C with a one to many 
relationship, and link table B to C with a one to many relationship. 

The following diagram shows how a many to many relationship would look.  Table 'C' 
is in the middle. 
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FORMS 

Forms provide a more user-friendly way to enter new data or view existing data, than 
working directly in a table. 

You can also use forms to view and edit data from two separate tables (that are linked 
together). 

  
This form displays data from one table. This form displays data from two linked 

tables.  This is known as a main form 
containing a subform (a main/subform). 

CREATING A FORM 
The easiest way to create a new form is to use the Form Wizard.  You can then 
customise the form in design view if you need to. 

A form can be based on a table or a query. 

These are the steps to create a simple form based on one table. 

To Create A Simple Form 

• Click on the "Forms" tab in the Database window 

• Click on the "New" button 

 

The New Form dialog box will appear. 

The first step is to choose the type of form 
you wish to create, and then the table or 
query that you want to base the form on. 

• Select "Form Wizard" 

• In the drop down menu, select a 
table (or query) 

• Click “OK” 
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The first dialog box in the Form Wizard 
will appear. 

This is used to select which fields you 
want to appear on the form. 

The available fields are shown on the 
left. 

• Double click on each field you 
wish to add 

The selected fields will be moved to the 
box on the right. 

 

☺TIP  You can click on the  button to add select all the fields in one go. 

 

You can now select a layout for the 
form. 

Columnar is probably the most 
commonly used layout. 

• Select a layout 

• Click “Next” 

You can now choose a format style for 
the form. 

• Select a style 

• Click “Next” 
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You can now choose a title for the 
form.   

In Access 2000 this is the name the 
form is Saved As (not a text title that 
appears on the form). 

• Enter a title for the form 

• Click “Finish” 

The form will be created, showing data 
from the table the form is based on. 

 
 
 

To Close The Form 

• In the "File" menu, select "Close" 

 
 

Changing A Form 
If you want to change the position of the fields on the form, add or delete fields, or 
change the fonts and colours used on the form, then you will need to edit the form in 
Design View.  (See section on Editing a Form). 
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CREATING A MAIN/SUBFORM 

A main/subform displays 
data from two tables 
linked together in a one to 
many relationship.  

The main part of the form 
is based on the ‘One’ 
table.  The subform is 
based on the ‘Many’ table. 

You must set up the 
relationship between 
the tables before you 
create a main/subform. 

To Create A Main/Subform 
In the Forms tab in the Database 
Window. 

• Click on the “New” button 

The New Form dialog box will appear. 

• Select "Form Wizard" 

• Select the table you wish to 
base the main form on 

• Click “OK” 

 

You can now choose which fields from 
the main table appear on the form. 

• Double click on each field you 
wish to add 

You can now select and add fields from 
another table. 

In the Tables/Query drop down list. 

• Select the table you wish to 
base the subform on 

• Double click on each field you 
wish to add 

The selected fields will all be moved to the box on the right. 

• Click “Next” 
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You will now be asked how you wish to 
view the data from the tables on the 
form. 

The names of both tables will be 
displayed. 

In the list of tables. 

• Select the main table 

• Ensure the Form with 
subform(s) option is selected 

• Click “Next” 

You can now choose a layout for the 
subform.  Datasheet is best. 

• Select Datasheet 

• Click “Next” 

You can now choose a format style for 
the main form. 

• Select a style 

• Click “Next” 
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The main form and the subform are 
saved as two separate objects.  (But 
you need only open the main form to 
view both together). 

You can now choose names to save 
the main form and the subform as. 

• Enter a title for the main form 

• Enter a title for the subform 

• Click "Finish" 

The main/subform form will then appear. 

Main 
Form

Subform

Subform
Navigation Buttons

Main Form 
Navigation Buttons  

The main form fields appear at the top of the form. 

The navigation buttons for the main form records appear at the very bottom of the 
window. 

The subform fields appear in datasheet format at the bottom of the form, with the 
navigation buttons for these subform records just underneath. 

To Close The Form 

• In the "File" menu, select "Close" 

Changing A Form 
If you wish to make changes to the appearance of the form or add new fields to it, you 
can edit it in design view. 

• Click on the "Design View" button   

See next section for editing a form in design view. 
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EDITING A FORM 

You can edit an existing form to change the position and formats of the fields, the field 
labels and the form background.  These edits are made to the form in design view. 

If the form is already open (in Form View), you can change to Design View. 

To Change To Design View 

• Click on the "Design View" button   

If the form is not already open, you can open it directly in Design View. 

To Open A Form In Design View 

• Select the form in the Database window 

• Click on the "Design" button 

 

The form will be displayed in Design View. 

 

 

The Detail area contains the field controls for each record.  In this picture the field 
controls are all text boxes.  Each field control has a label. 

Field Label Field Control (Text Box)  

In this section we will look at selecting, moving, resizing and formatting the fields and 
labels on a form. 
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To Select A Field Or Label 

• Click on the field or label  

The eight sizing handles will appear around the field or label.  The bigger handle in the 
top left corner is the move handle.  When you select a field the label associated with it 
is also partially selected (so the move handle becomes visible) and vice versa. 

Field Selected Label Selected 

  
 

To Move A Field Or Label 

• Click to select the field or label 

• Click and drag on the move handle on the top left corner of the field or label 

☺TIP  To move both the field and its label at the same time, you can click and drag 
on the border of the field or label (whichever is selected).  A hand icon will 
appear when the cursor is positioned correctly. 

 
If you change the order of the fields on the form, you will need to change the Tab 
Order (see Setting The Tab Order). 

 

To Resize A Field Or Label 

• Click to select the field or label 

• Click and drag on one of the sizing handles around the selected control (but 
not the larger move handle) 

 

To Reformat A Field Or Label 
You can reformat a field or label to change the font, size, alignment, colour and border 
width.  The easiest way to make these changes is using the buttons on the Formatting 
Toolbar. 

Font Size

Bold
Italic

Underline

Left Align
Centre Align

Right Align

Font Colour
Border Colour

Back Colour

Border Width
Border Effect

 
• Click to select the field or label 

• Click on the appropriate formatting button  
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To Change A Label Name 
You can rename any field label. 

• Click to select the label 

• Click again on the label text to insert the flashing text insertion point into the 
text 

• Use the [Backspace] or [Delete] keys to delete the existing label caption and 
then type a new one 

 

To Delete A Field Or Label 

• Click to select the control 

• Press [Delete] 

 

To Undo A Mistake 

• In the "Edit" menu, select "Undo" or you can use the keyboard shortcut 
[Ctrl]+[Z] 

 
 
 

You can also move, resize or reformat, several fields or labels at the same time.  This 
will save you a lot of time. 

To do this you need to select all the fields or labels that you wish to change. 

 

To Select Multiple Fields Or Labels 

• Click to select the first field or label 

• Hold down the [Shift] key and click to select each additional field or label 

You can now move, resize or reformat all the select fields or labels, using the same 
steps for changing one field or label. 

 

☺TIP  
There is a faster method for selecting a large number of fields and/or labels. 

Click on an empty part of the form and drag across the form, to create a 
rectangular selection box.  When you release the mouse, everything that is 
wholly or partially included in the box will be selected. 

If you have selected an extra field/label by mistake, you can hold down the 
[Shift] key and click on the field/label to deselect it. 
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ALIGNING, SPACING AND SIZING 

Once you start moving and resizing fields and labels, the form can get a bit messy. 

You can use the align, space and size commands to keep the form neat and tidy. 

 

To Align Fields Or Labels 
If you have moved or resized some fields or labels, you may wish to line them up 
neatly.  This can be done using the Align command. 

• Select all the fields or labels that you wish to align 

• In the "Format" menu, select "Align" to bring up the alignment options 

You can align elements by their tops, rights, lefts or bottoms. 

• Select the appropriate alignment option 

 

To Space Out Fields Or Labels 
You can use the horizontal and vertical spacing options to space fields and labels 
evenly across the form, or to increase or decrease the spacing between them. 

• Select all the fields or labels that you wish to space out 

• In the "Format" menu, select "Horizontal Spacing" or "Vertical Spacing", 
then choose "Make Equal", "Increase" or "Decrease" 

 

To Size Fields Or Labels 
The size options allow you to resize fields and labels to ensure that they are all the 
same size. 

• Select all the fields or labels that you wish to size 

• In the "Format" menu, select "Size" 

A submenu of size options will appear: 

Option Result 

Fit Adjusts fields and labels to fit the text they contain 

Grid Adjusts fields and labels in or out to meet the nearest points on 
the forms grid 

Shortest Makes the selected controls the height of the shortest control 

Tallest Makes the selected controls the height of the tallest control 

Widest Makes the selected controls the width of the widest control 

Narrowest Makes the selected controls the width of the narrowest control 

• Select the appropriate size option 
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CHANGING COLOURS ON A FORM 

You can change the colours of any field or 
label on the form.  You can also change 
the colour of the form background. 

Colours are changed using the colour 
buttons on the Formatting toolbar. 

There is also a Border Width button to 
change the width of a field control, and a 
Border Effect button to change the border 
style of a field control (eg to give it a 
shadow, or make it invisible). 

 

Font Colour
Border Colour

Back Colour

Border Width
Border Effect

Each button contains a drop down arrow.  Click on the 
arrow to bring up a menu of all the choices.   

The picture on the left of the button changes to show the 
last choice you selected.  You can click on this to apply the 
same choice again. 

Drop Down Arrow

 

 

To Change The Colour Or Border Style Of A Field Or Label  

• Click to select the field or label you wish to change 

• Select the colour or border style you with to apply using the appropriate 
button on the Formatting toolbar 

 

To Change The Background Colour Of The Form 

• Click to select the form background 

• Use the “Back Colour” button to select an appropriate colour 

 

☺ TIP You can use the Format Painter tool to copy and paste the formatting from one 
field or label to another. 

 

To Copy And Paste Formatting 

• Select the field or label containing the formatting you wish to copy 

• Click on the “Format Painter” tool  to copy the formatting 

• Click on the field or label you wish to apply the formatting to 
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CONDITIONAL FORMATTING 

This is a new feature in Access 2000. 

Conditional formatting is used on a form to change the formatting of a field when a 
particular value appears in the field. 

This is very useful if you want to highlight or monitor particular values.  For example if 
you had a field showing tenants arrears, you could make the number change to red for 
all records where the arrears was a negative value. 

You can actually have four different formats on one field - one default format and then 
up to 3 conditional formats. 

Conditional formatting can be applied to text box and combo box fields. 

To Apply Conditional Formatting 
In form design view. 

• Select the field control you wish to format 

• In the “Format” menu, select “Conditional Formatting” 

The Conditional Formatting dialog box will appear. 

 

At the top you can set the default format style.  This is applied to all values that do not 
match the conditions you set underneath. 

Standard format buttons in the dialog box - 
bold, italic, underline, fill colour and text 
colour -  are used to set the default and 
conditional formats. 

There is also an Enable/Disable button.  This 
is used to lock a field so that its contents 
cannot be edited. 

• Use the format buttons to set the 
default format 

 

Italic
Underline

Enable/
Disable

Fill Colour
Text Colour

Bold
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In the Condition 1 area, you can set the first conditional format.  

 

• In the first drop down list, ensure Field Value Is is selected 

• In the second drop down list, select a comparison phrase such as equal to, or 
greater than 

• In the third box, enter a value  

You can now choose the format you wish to by applied if the condition is met. 

• Select the formatting 

If you want to create a second format condition, you can click on the “Add” button.  A 
Condition 2 area will appear in the dialog box.  Repeat the previous steps to set the 
second condition. 

To apply the formatting. 

• Click “OK” 

 

 

You can also make the formatting change when the field is selected using the mouse 
or the tab key (regardless of the value in the field).  This is known as having the 
‘focus’. 

This is useful for highlighting the field that is currently being edited on the form. 

To Apply Conditional Formatting (On Focus) 

• Select the field you wish to format 

• In the “Format” menu, select “Conditional Formatting” 

The Conditional Formatting dialog box will appear. 

• Set the default format 
In the Condition 1 area. 

• In the first drop down list, select Field Has Focus 

 

• Select the formatting you wish to apply 

• Click “OK” 
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SETTING THE TAB ORDER 

The tab key can be used to move from field to field on a form, when you are inputting 
data.   

The tab order is the order in which you move through the fields as you press the tab 
key. 

The initial tab order is determined automatically when you create the form.  But if you 
then change the order of the fields on the form, the tab order will need to be changed 
so that the tab key will move you through the fields in the new order. 

To Reset The Tab Order 
You can only change the tab order if you looking at the form in design view. 

• In the "Edit" menu, select "Tab Order" 
The Tab Order dialog box will appear. 

 

The current tab order for the fields is shown in the Custom Order box.  The small grey 
box to the left of the field name is the field selector used to select and reorder the 
fields. 

• Click on a field selector to select a field (and then release the mouse) 

• Click and drag on the field selector to move the field up or down the list of 
fields 

You can use these steps to reorder all the fields on the form. 

• Click on the "OK" button to save the new tab order 
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CREATING A NEW BLANK FORM 

If you wish to create a form that is unlike any of the existing forms in the Form Wizard, 
you can either create a new form using the form wizard, and then edit it.  Or you can 
create a new blank form from scratch and design it to suit your needs. 

You can use the Form Design Toolbox to add a variety of field controls to the form, 
such as drop down lists and check boxes, to control the data inputting process. 

To Create A New Blank Form 

• Select the "Forms" tab in the Database 
Window 

• Click on the "New" button 

The New Form dialog box will appear. 

• Select Design View 

You must now choose which table or query you 
wish to base the form on.    

 

☺ TIP If you want to create a form to display data from two tables, you should create a 
query containing data from both tables, then base the form on that query. 

 
• Select the Table or Query you would like to base the form on 

• Click “OK” 

A new blank form will be created based on the select table or query. 

 

Hopefully the Toolbox will be visible, containing buttons for adding fields controls and 
labels to the form, and the Field List containing the names of all the fields in the table 
that the form is based on.  If they are not showing: 

• Click on the “Toolbox” button  to display the toolbox. 

• Click on the “Field List” button  to display the field list 
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PROPERTIES 

Each field control and label (and form) has a set of properties that determine its 
position, format and behaviour. 

Some of these properties can be changed in other ways, eg 
you can change the position of a control by dragging it with 
the mouse, or you can change the formatting of a label 
using the formatting buttons.   

But some properties can only be changed using the 
Properties window. 

To View The Properties Window 
You can only view the properties in form design view. 

• Click on the “Properties” button  

The Properties Window will appear showing the properties 
of the control, label or form that is currently selected.   

You can view all the properties for the selected object at 
once, or view groups of properties.  There are tabs at the 
top of the property window that allow you to choose which 
properties are displayed.   

 

(Ensure the "All" tab is selected while you work through this manual). 

To View The Properties For A Control Or Label 

• Click on the “Properties” button  to display the Properties window 

• Click to select the control or label 

To View The Properties Of The Form 

• Click on the small grey box in 
the top left hand corner of the 
form  

The properties shown will vary slightly depending on whether a control, label or form is 
selected.  These are some of the useful properties for fields, labels or forms: 

Property What Is It? 
Control Source The field the text box is linked to in the underlying table. 
Record Source The table or query the form is based on. 
Caption The text label that appears on the form. 
Left and Top The position of the control from the left of the form and the top 

of the form. 
Default View Determines how a form is displayed.  (New blank forms are 

set as 'Continuous Forms'.  You will probably want to select 
'Single Form'). 
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FORM DESIGN TOOLBOX 

The Toolbox allows you to add field controls and labels to any form. 

There are several different types of field controls (apart from the basic text box) that 
can be used on a form to control the data inputting process. 

These are the steps for using the toolbox buttons to add labels and controls. 

Select Objects

Label
Option Group
Option Button
Combo Box

Control Wizards

Text Box

Check Box

List Box

Subform

 

 

These are the most commonly used buttons: 

Button Function 

Select Objects Used to select labels and controls on the form. 

Label Add text labels to the form. 

Option Group Adds an Option Group control to the form 

Option Button Adds an Option Button control to the form 

Combo Box Adds a Combo Box control to the form 

Subform Adds a subform to the form 

Control Wizards Turns on the wizards 

Text Box Adds a Text Box control to the form 

Check Box Adds a Check Box control to the form 

List Box Adds a List Box control to the form 
 
 



www.ebitsolutions.net SEPTEMBER 1999 
 
 

 
INTERMEDIATE ACCESS 2000 
IT Support London 
Free Microsoft Office Training Manuals  

43

ADDING FIELD CONTROLS TO A FORM 

In form design view, the Toolbox buttons are used to add a variety of labels and field 
controls to any form. 

ADDING A LABEL 
Labels are used to describe a field control or 
as a heading for a form. 

• Click to select the "Label" button 
 

• Click and drag on the form to choose the position and size of the label on the 
form 

A white box will appear, containing the flashing text insertion point. 

• Type the text you wish to appear in the label 

Changing The Label Text 

• Click to select the label you wish to edit 

• Click on the label again to enter edit mode 

• Type the new text 

ADDING A TEXT BOX 
The text box control is the most common 
field type. 

• Click to select the “Text Box” button 

 
 

• Click and drag on the form to chose the position and size of the text box on 
the form 

You must now link the box to the appropriate field in the underlying table (by assigning 
a Control Source – see next page). 

 

☺ TIP You can now add text boxes to forms using the Field List.  And if you use this 
method you do not have to assign a Control Source (as it does it for you). 

Click on the “Field List” button  to display a list of all the available fields.  
Then drag the name of the field you wish to add onto the form.  A text box and a 
label will appear on the form.   
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To Assign a Control Source 
This is done by editing the properties for the control (see section on Properties). 

• Click to select the control 

• Click in the Control Source property 
box 

A drop down arrow will appear. 

 

• Click on the drop down arrow to bring up list of all the fields available and 
select the appropriate field 

The control is now linked to the selected field. 

 

 

ADDING A CHECK BOX 
A Check Box is a yes/no (true/false) option. 

 

Check boxes can only be used with fields that have been given a Yes/No data type (in 
table design view) 

• Click to select the "Check Box" control on the Toolbox  

• Click and drag on the form to choose the position and size of the check box 
on the form 

You must now link the box to the appropriate field in the underlying table by assigning 
a Control Source (see previous steps). 

 

 

ADDING A COMBO BOX 
Combo boxes are used to provide you with a 
drop down list of options.  The list is 
accessed by clicking on the drop down arrow 
at the right of the box.  You then click on the 
appropriate option in the list to select it. 

If there is no appropriate option in the list you 
can type something different into the box at 
the top of the list. 

There is a wizard to help you create a combo 
box (see section on Creating A Combo Box). 
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ADDING A LIST BOX 
List boxes are used to provide you with a list 
of options and to force you to choose one of 
those options. 

If the list is long a scroll bar will appear on 
the right to enable you to scroll up and down 
the list. 

There is a wizard to help you create a list box 
(see section on Creating A Combo Box). 

 

 

 

ADDING AN OPTION GROUP 
An Option Group is a collection of option 
buttons (of which only one can be selected). 

There is a wizard to help you create an 
option group (see section on Creating An 
Option Group). 
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CREATING A COMBO BOX (OR LIST BOX) 

You can add a drop down list to a form that enables users to select choices from an 
existing list, rather than type in the data.  This speeds up the data inputting process 
and ensures consistency. 

For example if you had a field for Office Location, you could create a drop down list of 
all the available offices. 

There are two types of drop down lists - Combo box and List box. 

COMBO BOX 

The Combo box has a drop down arrow 
that you click on to bring up a drop down 
list. 

LIST BOX  

The List box has a scroll bar for you to 
scroll up and down the list. 

 
 

Advantages 

Takes up less room on the form (because 
the list isn't shown until you click on the 
drop down arrow). 

If the value you wish to enter isn't 
displayed on the form you can type it in 
(you can disable this). 

Advantages 

The values in the list are visible on the 
form without you having to click on 
anything (unless the list is long, then you 
have to use the scroll bar). 

Users cannot select a value that does not 
appear in the list. 

 
These are the steps to create a combo box (the list box is very similar). 

CREATING A COMBO BOX 
The best way to add a combo box to a form is to create a table (that will contain the 
list of choices) and then to use the control Wizard to add the combo box to the form. 

To Create A Table For A Drop Down List 
In the Table tab in the Database window. 

• Click on the "New" button to create a new table 

• Select "Design View 

The Table Design window will appear." 
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In the Table Design window. 

• Enter a field name for the list 
of values 

• Enter an appropriate data 
type 

 

 

☺TIP  If you want the values in your list to appear in alphabetical (or numerical) 
order, you should change the Indexed property for the field to Yes. 

 

• Click on the "Datasheet View" button  

You will then be asked if you want to save the table. 

• Click on "OK" 

• Give the table a name 

You may want to use a name that 
differentiates this table from your main 
data tables. 

• Click on "OK" 

You will then be asked if you wish to 
create a primary key.  You do not 
need to have a primary key in a 
table that is being used to feed a 
combo box or list box. 

• Click on "No" 

The table will be shown in datasheet 
view. 

• Enter the values that you 
want to appear in the list 

• In the "File" menu, select 
"Close" to close the table 

You are now ready to create the 
combo box. 
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To Create A Combo Box 

• Open the Form you wish to put the combo box on, in Design view 

• Ensure the Toolbox is showing 

• Ensure that the "Control Wizard" button is selected  on the Toolbox 

• Select the "Combo Box" button   (or the "List Box" button if you wish to 
add a List Box) 

• Click and drag across the form to establish the size and position of the field 
control on the form (you can move or resize it later) 

When you release the mouse button, 
a Wizard will appear to help you 
create the combo box (because the 
Control Wizard button was turned on). 

• Select "I want the combo box 
to look up the values in a 
table or query" 

• Click on "Next" 

You must now tell Access which table 
or query contains the values that are 
to appear in the combo box. 

• Select the table containing the 
values for the list 

• Click "Next" 

You must now tell Access which fields in the 
selected table contain the values that are to 
appear in the combo box. 
All the available fields in the table are listed 
on the left. 

• Select the appropriate field 

• Click on the "Add" button  
to add the field to the box on 
the right 

• Click "Next" 



www.ebitsolutions.net SEPTEMBER 1999 
 
 

 
INTERMEDIATE ACCESS 2000 
IT Support London 
Free Microsoft Office Training Manuals  

49

You now get a chance to choose the 
width of the column(s) in the drop 
down list. 

• Drag on the right border of the 
column heading to resize the 
column 

• Click "Next" 

You must now tell Access where you 
want it to store the values each time 
someone selects a value in the drop 
down list. 

• Select "Store that value in 
this field" 

The drop down list on the right will 
contain all the fields in the table or 
query that the form is based on. 

• Select the field that relates to 
the values in the combo box 

• Click "Next" 
 

You can now enter an appropriate 
label for the combo box field. 

• Enter a label name 

• Click on the "Finish" button 

 

The combo box will be added to the form. 

 
You can now look at the form in Form View, to test the combo box. 

If you ever need a new value to appear in the list, you should open the table 
containing the values for the list and enter the new value. 
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CREATING AN OPTION GROUP 

An option group is used to provide a list of 
options, only one of which can be selected. 

The value selected in an option group is 
stored in the table as a number 
(eg: Good = 1, Average = 2, Poor = 3).   
If you wish to be able to perform statistical 
analysis on these numbers, you should 
ensure that the data type for this field is set 
as a Number. 

 

If you would prefer to have the options stored in your table as text, you should 
probably use a combo box instead of an option group. 

These are the steps to create an option group. 

• In design view on your form, ensure the "Control Wizard" button is selected 
on the Toolbox  

• Select the "Option Group" button on the Toolbox 

 

• Click and drag across the form to choose the position and size of the option 
group 

 
The Option Group Wizard will appear. 

You must now specify what options you wish 
to be displayed on the form. 

• Enter the values/options you wish to 
be available 

• Click "Next" 

The next dialog box allows you to specify a 
default value.   

This is useful if one value is more common 
than any of the others.  If this is not the case, 
choose no default value. 

• Select the appropriate option 

• Click "Next" 
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Access assigns numerical values to the 
options/values you have created. 

These are the values that will appear in the 
table.  But you can change them if you would 
like to use other numerical values. 

• Change values if necessary 

• Click "Next" 

You must now specify which field you wish to 
store these numerical values in. 

• Select the "Store the value in this 
field" option, and choose the 
appropriate field in the drop down 
menu 

• Click "Next" 

You can now choose a format style for the 
option group controls. 

• Select appropriate format 

• Click "Next" 

You can now choose a label for the option 
group. 

• Enter a name for the group 

• Click "Finish" 

The Option Group will be created. 
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EXPRESSIONS 

Expressions can be used on a form to display useful information or perform 
calculations. 

For example you could use an expression to display the current date or to calculate 
the VAT by multiplying values by 17.5%. 

The result of an expression is NOT stored in the table, it is only displayed on the form. 

Expressions are created in a text box control on the form. 

To Create An Expression 
This must be done in form design view. 

• Click on the "Text Box" button on the Toolbox  and then click and drag 
across the form to add a text box 

• Click in the text box and enter the appropriate expression 

 

Here are some examples. 

Field names always appear in square brackets, eg [Firstname]. 

Expression Result 

=Date() Displays the current date. 

=[Firstname] & " " & [Lastname] Combines the Firstname field with a space and 
then the Lastname field to display the full name. 

=[Salary]*0.24 Calculates 24% of the value in the Salary field. 

=Date()-[DoB] Subtracts the DoB (date of birth) field from the 
current date to display the age in days. 

=(Date()-[DoB])/365.25 Subtracts the DoB (date of birth) field from the 
current date, and divides it all by 365.25, to 
display the age in years. 

=Int((Date()-[DoB])/365.25) This is the best formula for calculating age as it 
rounds the result down and displays it as a 
whole number. 

=[Startdate]+7 Displays the date 7 days from the date in the 
Startdate field. 

=[Price]*0.175 Multiplies the Price field by 17.5%. 

=([Price]*0.175)+[Price] Multiplies the Price field by 17.5% and adds the 
result to the original price. 

You will probably also want to change the caption property of the text box label to give 
it an appropriate name. 

When you view the text box in form view, the result of the expression is displayed. 
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CREATING A DROP DOWN LIST IN A TABLE 

This is a new feature that appeared in Access 97. 

You can now create drop down lists in tables.  This is useful if you like to input data 
directly into tables. 

 
As with Combo Box on a form you should create a new table to hold the values that 
will be displayed in the drop down list.  These steps are covered in the section 
Creating a Combo Box. 

Assuming you have already created a table to hold the drop down list values: 

• Open the table, in which you wish the drop down list to appear, in design view 

• Select the field that is to display the drop down list 

In the Field Properties. 

• Select the Lookup tab 

• Change the Display Control property to Combo Box 

Some new properties will appear. 

• Click in the Row Source 
property box 

A drop down menu will appear. 

• Click on the drop down 
arrow to display a list of 
all the tables and queries 
in the database.  Select 
the table containing the 
values for the drop down 
list 

• Save the changes to the 
table 

You can now view the table in datasheet view.  The drop down menu will now appear 
when you click in the amended field. 
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IMPORTING DATA 

If you already have data in an alternative source, such as Excel, you can import it into 
your database. 

You can either import the data into the database as a new table, or you can import it 
into an existing table. 

Your data must be set up in 
Excel as one large data 
table, starting at the top of 
the first sheet in the book. 

Row 1 must contain 
headings for the columns of 
data. 

These headings will be 
used as the field names in 
the Access table. 

 

Importing Data Into An Existing Access Table 
There are a few things to bear in mind if you wish to import the data into an existing 
table. 

The columns of data do not have to be arranged in the same order in the Excel 
spreadsheet as they are in the Access table, but... 

The column headings in Excel must be identical to the matching field names in the 
Access table. 

You do not have to import the same number of columns of data.  But if there are more 
columns of data in the Excel spreadsheet than in the Access table, the extra columns 
will not be imported unless you create new fields for those extra columns (with the 
same name as the headings in Excel). 

To Import Data From Excel 
In Access, having closed down all tables and forms. 

• In the "File" menu, select “Get External Data”, then select "Import" 
The Import dialog box will appear. 

• In the Files of Type drop down menu, 
select Microsoft Excel 

• Navigate through the folder structure to 
select the excel file containing the 
data 

• Click "Import"  
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The Import Wizard will start up.   

You can view the data in the 
workbook by named ranges or just by 
sheets. 

• Select appropriate option 

• Click “Next” 

If there is a row of headings in your 
spreadsheet, these can be used as 
the field names for the imported data 
in Access. 

• Select “First Row Contains 
Column Headings” 

• Click “Next” 

You can now choose to import the 
data into a new table or add it to an 
existing table. 

If you choose an existing table, you 
must specify the table, and then 
Access will only import the columns 
whose headings exactly match 
existing field names in the selected 
table. 

• Select the appropriate option 

• Click “Next” 

If you chose to add the data to an existing table, one final dialog box will appear 
confirming your choice.  You can then click on the “Finish” button to import the data as 
new records at the bottom of the selected table. 

If you chose to import the data as a new table – see next steps. 
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This dialog box can be used to 
change the field names, turn on 
indexing or choose not to import a 
particular column. 

But you can do all these things to the 
table in design view once the data has 
been imported. 

• Select “Next”  

You can now let Access create an 
extra ID field to be used as the 
primary key, choose an existing 
column of data as the primary key, or 
select no primary key. 

If this table is going to be linked to 
another table in a one to many 
relationship, it will need to have a 
primary key (if it is the main table in 
the relationship). 

• Select the appropriate option 

• Click “Next” 

You can now enter a name for the 
new imported table of data. 

• Enter a name 

• Click “Finish” 

 

Hopefully you will be informed that the 
data has been imported successfully. 

• Click "OK" 

 

A new table will be created, visible in 
the table tab in the database window. 

 

 

Importing Data From Word 
If you have data in a Word table that you wish to import into Access, you could copy 
and paste the data into Excel and then follow the steps for importing data from Excel. 
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PRINT RELATIONSHIPS 

You can now print out the relationships between the tables in your database.   

 

This can be useful for showing other people how the database has been constructed, 
especially for more complex databases. 

 

This is done in the Relationships window. 

• In the “Tools” menu, select “Relationships” 

• In “File” menu, select “Print Relationships” 

Access will create a report showing the relationships between the tables. 

• Click on the “Print” button to print the report 

 

You can also save this report for later use. 

 



SEPTEMBER 1999 EBIT SOLUTIONS LIMITED 
 
 

 
  INTERMEDIATE ACCESS 2000 58 

CONVERTING AN OLD ACCESS DATABASE 

You can open an Access 2 or an Access 97 database in Access 2000.  But the 
database will open in read-only mode.  This means you can view the data, but you 
can’t create any new tables, queries, forms or reports, or modify any existing ones.  To 
do that you will need to convert your database to Access 2000. 

If the database is simple, ie it does not contain lots of clever features using Access 
Basic programming, it should convert easily.  If in doubt, contact the IT Helpdesk or 
the person who originally created the database. 

To Convert A Database To Access 2000 

• Open Access 2000, but do not open a database 

• In the “Tools” menu, select “Database Utilities”, then “Convert Database”, 
then “To Current Access Database Version” 

The Database to Convert From 
dialog box will appear. 

• Navigate through the 
folder structure and 
select the database you 
wish to convert 

• Click on the “Convert” 
button 

  

An identical looking dialog box 
will appear.  This one is used to 
save a copy of the converted 
database. 

In the Convert Database Into 
dialog box. 

• Enter a name for the 
converted database and 
select a folder to save it in

• Click on the “Save” button
 

 

A new copy of the database will be created that is Access 2000 compatible.  The 
original database will still exist in the old format. 

 
You should then open the converted database in Access 2000 and check to see that it 
functions properly and contains all the correct data. 

Do not delete the old database until you are certain there are no problems with the 
new one. 


